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GETTING STARTED GUIDE

NI Digital Multimeters
For the NI PCMCIA-4050, NI PXI/PCI-4060, 
NI PXI/PCI-4070, and NI PXI-4072

This document explains how to install, configure, test, and set up an 
NI PCMCIA-4050, NI PXI/PCI-4060, NI PXI/PCI-4070, or NI PXI-4072 
National Instruments digital multimeter (DMM) for common measurements. 
For more information on the DMM, such as features and programming, refer 
to the NI Digital Multimeters Help file at Start»Programs»National 
Instruments»NI-DMM»Documentation»NI Digital Multimeters Help.

Detailed specifications about the DMM are available in the specifications 
document included with the DMM.

For the most current versions of specifications and other documentation, visit 
ni.com/manuals.
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Conventions
The following conventions are used in this manual:

 » The » symbol leads you through nested menu items 
and dialog box options to a final action. The 
sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup 
item, and select Options from the last dialog box.

♦ The ♦ symbol indicates that the following text 
applies only to a specific product.

This icon denotes a tip, which alerts you to advisory 
information.

This icon denotes a note, which alerts you to 
important information.
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This icon denotes a caution, which advises you of 
precautions to take to avoid injury, data loss, or a 
system crash. When this symbol is marked on a 
product, refer to the Read Me First: Safety and 
Radio-Frequency Interference document included 
with the device for precautions to take.

bold Bold text denotes items that you must select or click 
in the software, such as menu items and dialog box 
options. Bold text also denotes parameter names.

DMM Digital multimeter—refers to the 
NI PCMCIA-4050, NI PXI-4060, NI PCI-4060, 
NI PXI-4070, NI PCI-4070, or NI PXI-4072.

italic Italic text denotes variables, emphasis, a cross 
reference, hardware labels, or an introduction to a 
key concept. This font also denotes text that is a 
placeholder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you 
should enter from the keyboard and programming 
examples. This font is also used for the proper 
names of disk drives, paths, directories, programs, 
and filenames.

monospace Italic text in this font denotes text that is a
italic placeholder for a word or value that you must 

supply.

NI 4050 Refers to the NI PCMCIA-4050.

NI 4060 Refers to the NI PXI/PCI-4060.

NI 4070 Refers to the NI PXI/PCI-4070.

NI 4072 Refers to the NI PXI-4072.
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1. Verifying the System Requirements
This section specifies the minimum system requirements and recommended 
system for NI-DMM 2.3 and later.

Minimum System Requirements
• Processor: Pentium 200 MHz or equivalent 

• RAM: 64 MB

• PXI chassis and controller, desktop computer, or laptop with a 
PCMCIA slot

• 1/8 in. flathead screwdriver

• Number 1 Phillips screwdriver

Recommended System
• Processor: Pentium III/Celeron 600 MHz or equivalent 

• RAM: 256 MB 

• One of the following operating systems: 

– Windows 2000 

– Windows NT 4.0 service pack 6 

– Windows XP 

• One of the following Application Development Environments (ADEs) 
and associated documentation: 

– NI LabVIEW 7.0 or later

– NI LabWindows™/CVI™ 6.0 or later 

– Microsoft Visual C++ 6.0 or later 

� Microsoft Visual Basic 6.0

Note Waveform acquisition performance at full rate (1.8 MS/s) 
on the NI 4070/4072 depends highly on system-specific factors 
such as CPU speed, memory architecture, and system chipset 
characteristics. Simultaneous acquisitions on multiple 
NI 4070/4072 devices or acquisitions of longer durations may 
require a faster processor or more memory. Other applications 
running at the same time may also affect performance.
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2. Unpacking
The DMM ships in an antistatic package to prevent electrostatic discharge 
(ESD). ESD can damage several components on the DMM.

Caution Never touch the exposed pins of connectors. 

To avoid damage in handling the DMM, take the following precautions:

• Ground yourself using a grounding strap or by touching a grounded 
object.

• Touch the antistatic package to a metal part of the computer chassis 
before removing the DMM from the package.

Remove the DMM from the package and inspect it for loose components or 
any sign of damage. Notify NI if the DMM appears damaged in any way. 
Do not install a damaged DMM into the computer or chassis.

Store the DMM in the antistatic envelope when not in use.

3. Verifying the Kit Contents
To set up and use the DMM, you need the following items:

❑ DVD-sized case, which includes the following items:

– NI-DMM driver software CD, which includes the NI Digital 
Multimeters Help

Note The NI PCI-4070 requires NI-DMM 2.2 or later. 
The NI 4072 requires NI-DMM 2.3 or later.

– NI Digital Multimeters Getting Started Guide

– NI-DMM Instrument Driver Quick Reference Guide

❑ NI 4050, NI 4060, or NI 4070/4072

❑ Test probes

❑ Specifications document included with the DMM

❑ Read Me First: Safety and Radio-Frequency Interference
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4. Installing the Software
Complete the following steps to install the software before installing 
the DMM.

1. Install an application development environment (ADE) such as 
NI LabVIEW, NI LabWindows/CVI, Microsoft Visual C++, or 
Microsoft Visual Basic.

2. Install the NI-DMM instrument driver software according to the 
instructions on the CD included with the DMM.

5. Installing the Hardware

Cautions You must power off the PC or PXI chassis before 
installing the DMM hardware.

To prevent damage to the DMM due to ESD or contamination, 
handle the device using the edges or the metal bracket.

Notes Install the NI-DMM software before installing the 
hardware.

Refer to Appendix B: Chassis Recommendations for more 
information about installing the DMM hardware in a PC or 
PXI chassis.

Installing the PXI DMM
To install the PXI DMM, refer to Figure 1 and complete the following steps:

1. Power off the PXI chassis.

2. Slide the PXI DMM into an available slot until the ejector handle locks 
in the up position.

3. Secure the PXI DMM with the screw provided.

4. Power on the PXI chassis.



© National Instruments Corporation 7 NI Digital Multimeters Getting Started Guide

Figure 1.  PXI Installation
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Installing the PCI DMM
To install the PCI DMM, refer to Figure 2 and complete the following steps:

1. Power off the PC and remove the cover.

2. Insert the PCI DMM into an open PCI slot.

3. Secure the PCI DMM with the screw provided.

4. Replace the PC cover.

5. Power on the computer.

Figure 2.  PCI Installation
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Installing the PCMCIA DMM
To install the PCMCIA DMM, insert the PCMCIA DMM into an open 
PCMCIA slot as shown in Figure 3.

Figure 3.  PCMCIA Installation

6. Configuring and Testing in MAX
To configure and test the DMM in Measurement & Automation Explorer 
(MAX), complete the following steps:

1. Launch MAX (Start»Programs»National Instruments»
Measurement & Automation). MAX detects the DMM you installed.

2. Expand Devices and Interfaces.

If you are using a DMM with the LabVIEW Real-Time Module, expand 
Remote Systems. Find your target device IP address or name, expand it, 
and then expand Devices and Interfaces.

3. Check that your DMM appears under Devices and Interfaces.

1 Laptop 2 PCMCIA Slot 3 NI 4050

1

2
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The DMMs appear in the Traditional NI-DAQ and NI-DAQmx folders in 
Devices and Interfaces, as follows.

Note If the DMM is not listed, press <F5> to refresh the list. 
If MAX does not recognize the DMM, refer to ni.com/support/
install for troubleshooting information.

When the NI PXI-4070, which is supported by both Traditional NI-DAQ 
and NI-DAQmx, is present with both versions of NI-DAQ, the 
NI PXI-4070 is listed with a different name under the Traditional 
NI-DAQ and NI-DAQmx folders in Devices and Interfaces.

Only NI-DAQmx devices are listed under Remote Systems»Devices 
and Interfaces.

4. Under the folder where your DMM appears, right-click your DMM.

• To test the DMM, perform one of the following steps.

– If the DMM is under Traditional NI-DAQ, select Properties and 
then click Test Resources in the Properties window.

– If the device is under NI-DAQmx, select Self-Test. If you need 
help during the self-test, open the Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics. 
When the self-test finishes, a message indicates a successful 
verification or the occurrence of an error. If an error occurs, refer 
to ni.com/support for troubleshooting information.

Note If the DMM does not pass the test, power off the PC, 
remove the DMM, and repeat the appropriate hardware installation 
procedure. If the DMM still does not pass the test, refer to 
ni.com/support.

• (NI-DAQmx Devices Only) To perform self-calibration, select 
Self-Calibrate. The DMM must warm up for at least 60 minutes 
before self-calibrating.

Device Folder Name

NI 4050
NI 4060

Traditional NI-DAQ

NI PXI-4070 Traditional NI-DAQ/NI-DAQmx

NI PCI-4070
NI 4072

NI-DAQmx
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♦ Steps 5 and 6 apply to the NI 4050/4060 only.

5. Right-click the NI 4050/4060, and click Test Panels to run the functional 
test panels and to use the DMM. Refer to the 7. Connecting Signals 
section to connect a signal to the DMM.

Note The Run Test Panels option currently is not available for the 
NI 4070/4072. Run the DMM Soft Front Panel (SFP) to run 
functional tests of the NI 4070/4072. You can launch the DMM 
SFP from Start»Programs»National Instruments»NI-DMM»
NI-DMM Soft Front Panel.

6. Click Close to close the test panels for the NI 4050/4060. 

7. Connecting Signals
The following sections explain how to connect signals to the DMM front 
panel connectors for common measurements. To learn more about these 
measurements, refer to the NI Digital Multimeters Help at Start»Programs»
National Instruments»NI-DMM»Documentation»NI Digital 
Multimeters Help.

Caution Always refer to the specifications document included with 
the DMM before connecting signals. Failure to observe the 
specified maximum signal ratings can cause shock, a fire hazard, or 
damage to the devices connected to the DMM. NI is not liable for 
any damage or injuries resulting from incorrect signal connections.

DC and AC Voltage

Figure 4.  NI 4050 Signal Connections for Voltage Measurements
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Figure 5.  NI 4060 and NI 4070/4072 Signal Connections for Voltage Measurements

DC and AC Current

Figure 6.  NI 4050 Signal Connections for Current Measurements

Note To measure current, the NI 4050 requires the 
NI CSM-200mA current shunt module (shown in Figure 6), 
which is available from NI.
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Figure 7.  NI 4060 and NI 4070/4072 Signal Connections for Current Measurements

Tip To measure current beyond the specifications of the 
NI 4060 and NI 4070/4072, a 10 A current shunt module, 
the NI CSM-10A, is available from NI. Refer to the 
NI CSM-10A/200mA Installation Guide at ni.com/manuals for 
more information. Refer to ni.com/instruments for purchasing 
information.

1 NI 4060 2 NI 4070/4072

6½-Digit FlexDMM5½-Digit Multimeter

1 2
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2-Wire Resistance

Figure 8.  NI 4050 Signal Connections for 2-Wire Resistance Measurements
 

Figure 9.  NI 4060, NI 4070/4072 Signal Connections 
for 2-Wire Resistance Measurements
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4-Wire Resistance
4-wire resistance measurements use both pairs of terminals, which allows 
you to measure low resistances accurately by eliminating the effects of lead 
resistance. 

Note The NI 4050 does not support 4-wire resistance 
measurements.

Figure 10.  NI 4060 and NI 4070/4072 Signal Connections 
for 4-Wire Resistance Measurements

1 NI 4060 2 NI 4070/4072

6½-Digit FlexDMM5½-Digit Multimeter

1 2
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Voltage Drop Across a Diode
The DMM can excite a device under test and read the resulting voltage drop, 
which is useful for testing diodes.

 

Figure 11.  NI 4050 Signal Connections for Diode Measurements

Figure 12.  NI 4060 and NI 4070/4072 Signal Connections for Diode Measurements
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Using Cables and Probes
The DMM kit contains a pair of test probes with safety banana jacks. These 
probes meet international safety requirements, including UL 3111 and 
IEC 1010-1, for the full range of applications supported by the DMM.

Caution Before using any probes or accessories not supplied by NI, 
ensure that they meet applicable safety requirements for the signal 
levels you may encounter.

Connect the test probes to the DMM front panel connectors using safety 
banana jacks. The shrouds around the banana jacks prevent you from 
contacting potentially hazardous voltages connected to the test probes. You 
also can connect the cable to standard, unshrouded banana jack probes or 
accessories. Use unshrouded probes or accessories only when the voltages 
are less than 30 Vrms and 42 Vpk, or 60 VDC.

Cautions NI 4050 users—To prevent possible safety hazards, the 
maximum voltage between either of the inputs and the ground of 
the computer should never exceed ±250 VDC or 250 Vrms.

NI 4060 users—To prevent possible safety hazards, the maximum 
voltage between either of the inputs and the ground of the computer 
should never exceed ±300 VDC or 300 Vrms. The maximum current 
that the NI 4060 can measure between the current inputs is 
±200 mA DC or 200 mArms.

NI 4070 and NI 4072 users—To prevent possible safety hazards, 
the maximum voltage between either of the inputs and the ground 
of the computer should never exceed ±300 VDC or 300 Vrms. 
The maximum current that the NI 4070 or NI 4072 can measure 
between the current inputs is ±1 A DC or 1 Arms.

8. Programming the DMM
You can acquire data with the DMM by using the DMM SFP or the NI-DMM 
instrument driver in your application, and you can run the NI-DMM 
examples to demonstrate the functionality of the DMMs.

DMM Soft Front Panel
The DMM SFP is a software representation of a traditional benchtop DMM. 
Use the DMM SFP to test the basic functionality of the DMM and become 
familiar with its operation.

You can launch the DMM SFP from Start»Programs»National 
Instruments»NI-DMM»NI-DMM Soft Front Panel.



NI Digital Multimeters Getting Started Guide 18 ni.com

NI-DMM Instrument Driver
NI-DMM features a set of operations and attributes that exercise all the 
functionality of the DMM, including configuration, control, and other 
module-specific functions. NI-DMM controls all NI digital multimeters.

Refer to the Programming section of the NI Digital Multimeters Help at 
Start»Programs»National Instruments»NI-DMM»Documentation»
NI Digital Multimeters Help for information on using NI-DMM in your 
applications.

NI-DMM Examples
The NI-DMM examples are instructional tools that demonstrate some of the 
functionality of the DMMs that you can use or integrate into your systems. 
NI-DMM includes examples covering single point measurements, multipoint 
measurements, triggering, waveform acquisitions (NI 4070/4072 only), and 
performance (NI 4070/4072 only).

The following table shows the location of the NI-DMM examples for all 
supported ADEs.

Tip For best accuracy, NI 4070/4072 users should run the Self-Cal 
example after their device has been installed and has warmed up.

Refer to the NI-DMM Programming Examples section of the NI Digital 
Multimeters Help at Start»Programs»National Instruments»NI-DMM»
Documentation»NI Digital Multimeters Help for a complete example list. 
Refer to ni.com/zone for examples that use National Instruments DMMs 
with National Instruments switch modules.

ADE Location

LabVIEW <LabVIEW>\examples\instr\niDMM

CVI <CVI>\samples\niDMM

C/C++1,2 <Measurement Studio>\VC\Examples\niDMM

VB1,2 <Measurement Studio>\VB\Samples\niDMM

1 Not all examples are available for Visual C/C++ and Visual Basic.
2 Any C and VB examples installed by a previous version of NI-DMM are copied to 
VXIpnp\WinNT\NIDMM\Examplesxx, where xx is the previous version number of 
NI-DMM. Delete this directory if you do not need the old examples.
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Appendix A: Front Panels
This appendix shows the front panels for National Instruments DMMs.

PXI/PCI
The PXI and PCI front panels contain five connectors—four shrouded 
banana jacks and one 9-pin connector. Figure 13 shows the front panels 
for the NI 4060 and the NI 4070/4072.

 

Figure 13.  Connections on the PXI and PCI Devices

The four banana jacks are high-voltage, safety signal connectors. The 9-pin 
connector labeled AUX I/O is a digital signal connector, which carries 
TTL-level triggering signals for use with external scanning equipment. 

1 NI PCI-4060
2 NI PXI-4060
3 NI PCI-4070

4 NI PXI-4070/4072
5 Banana Jack Connectors
6 9-Pin Connectors
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Refer to the NI Digital Multimeters Help, located at Start»Programs»
National Instruments»NI-DMM»Documentation»NI Digital 
Multimeters Help, for information about scanning.

PCMCIA
Caution To measure current with the NI PCMCIA-4050, you must 
use a current shunt. Refer to the DC and AC Current section for 
more information.

An accessory cable connects the NI PCMCIA-4050 to a pair of test probes 
equipped with shrouded banana jacks. Both the accessory cable and the test 
probes ship with the NI PCMCIA-4050.

Refer to Figure 14 to connect the accessory cable to the NI PCMCIA-4050. 
The accessory cable connector is polarized so that it cannot be plugged in 
incorrectly.

Figure 14.  Connecting Cables and Probes to the NI PCMCIA-4050
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Appendix B: Chassis Recommendations
This appendix specifies the recommended chassis components and 
conditions for a system that includes National Instruments DMMs.

PXI Chassis Recommendations
The NI PXI-4060, NI PXI-4070, and NI PXI-4072 are designed to operate in 
any PXI-compliant chassis. Normal operating conditions for these DMMs 
include the following:

• All PXI filler panels must be installed in empty slots.

• The PXI chassis fans that provide forced air must remain unobstructed to 
allow for proper cooling of the PXI chassis, devices, and controller.

• Routine maintenance of the chassis cooling fan filters must be performed 
to assure continuous cooling effectiveness.

Temperature rise on a module within a chassis can vary with slot position. 
You can keep this variation to a minimum by taking the precautions 
previously listed.

PCI Chassis Recommendations
The NI PCI-4060 and NI PCI-4070 are designed to operate in any 
ATX-compliant industrial or personal computer. Normal operating 
conditions for these DMMs include the following:

• All covers for the industrial chassis or personal computer must be 
installed.

• All PCI filler panels must be installed to close off unused PCI slots.

Caution For optimal electromagnetic compatibility (EMC) 
performance and input protection, you must install the front panel 
screw.

• The PCI front panel bracket on the NI PCI-4060 and NI PCI-4070 must 
have a firm, direct, metal-to-metal mounting connection to ensure proper 
grounding. Some computer manufacturers use a securing lever made of 
plastic; such a lever is unacceptable for safety reasons and must be 
removed. Also, the PCI devices must be screwed down. If the chassis 
does not meet these requirements, you must use a different computer 
chassis.

The cooling capability of most industrial and personal computers is less 
effective than the cooling capability in a PXI chassis. The NI PCI-4060 
dissipates low enough power that additional cooling is not needed in most 
computers. The NI PCI-4070 dissipates higher power, and NI strongly 
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recommends that NI PCI-4070 users implement the following precautions 
to maximize the cooling capability of the computer:

• Install an additional 80 mm, 32 cubic ft/min (CFM) fan that forces 
air towards the NI PCI-4060 or NI PCI-4070. Most computer chassis 
contain one or two mounting locations for this type of fan. These fans are 
inexpensive and readily available at most computer supply stores.

Note  If the hard drive mounts vertically in front of the fan 
mounting location(s) in the computer chassis, you must move the 
hard drive to a horizontal 3.5 in. drive bay or to another suitable 
location that does not obstruct the fan mounting location(s).

• Add additional fans, such as PCI fan cards and chassis fans, to increase 
the air circulation inside the computer.

Appendix C: Fuse Replacement
This appendix explains how to replace the fuse in the NI 4060 and 
NI 4070/4072.

Note The NI 4050 does not have a user-replacable fuse.

Replace the fuse with one of the fuse types listed in Table 1. To replace the 
fuse in the NI CSM-10A or NI CSM-200mA shunt modules, refer to the 
NI CSM-10A/200mA Installation Guide at ni.com/manuals.

Caution For continued protection against fire, replace the fuse only 
with fuses of the same type and rating. Refer to Table 1 for fuse 
types.

Table 1.  Appropriate Fuses for the NI 4060 and NI 4070/4072

DMM Fuse Rating Fuse Type Manufacturer

NI 4060 500 mA/250 V Fast acting Schurter

500 mA/250 V Fast acting Littelfuse

NI 4070 and NI 4072 1.25 A/250 V Fast acting Littelfuse
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NI 4060
To replace the fuse, complete the following steps:

♦ NI PXI-4060

1. Remove all front panel connections from the NI PXI-4060.

2. Power down the chassis and remove the device.

3. Hold the device at the angle shown in Figure 15, and locate the fuse 
holder.

Figure 15.  Removing the Fuse from the NI PXI-4060

4. Insert a screwdriver into the slot on the fuse holder.

5. Turn counterclockwise.

6. Pull out the holder and remove the 5 × 20 mm glass fuse.

7. Visually verify that the fuse is blown.

1 Fuse Holder

1
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8. Insert a new fuse into the holder and slide the holder back into place.

9. Turn the fuse holder clockwise until it snaps shut.

♦ NI PCI-4060

1. Remove all front panel connections from the NI PCI-4060.

2. Power off the computer and remove the device.

3. Remove the four screws that secure the top and bottom insulators onto 
the device, as shown in Figure 16.

Figure 16.  Removing the Insulators from the NI PCI-4060

4. Remove the bottom and top insulators.

5. Locate the 5 × 20 mm glass fuse shown in Figure 17.

1 Screws Securing Insulators 2 Insulators

1 2

2

1

1 1
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Figure 17.  Removing the Fuse from the NI PCI-4060

6. Visually verify that the fuse is blown and remove it.

7. Press the new fuse into the silver holding fixture until you hear a snap.

Caution Do not operate the NI PCI-4060 without both insulators 
replaced and secured.

8. Reattach the top and bottom insulators in the opposite order that you 
removed them.

1 Glass Fuse

1
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NI 4070/4072
♦ NI PXI-4070 and NI PXI-4072

To replace the fuse, complete the following steps:

1. Remove all front panel connections from the NI PXI-4070 
or NI PXI-4072.

2. Power off the chassis and remove the NI PXI-4070 or NI PXI-4072.

3. Locate the fuse hole shown in Figure 18.

Figure 18.  Removing the Fuse from the NI PXI-4070 and NI PXI-4072

4. Insert a screwdriver into the hole.

5. Gently press the fuse with the screwdriver until one of the fuse clamps 
releases.

Caution Do not cover the fuse slot on the opposite side of the 
NI PXI-4070 or NI PXI-4072 with your hand, as doing so may 
cause injury.

6. Locate the fuse slot shown in Figure 19.

1 Screwdriver 2 Fuse Hole

1

2
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Figure 19.  Removing the Fuse from the NI PXI-4070 or NI PXI-4072

7. Pry the fuse loose from the slot.

8. Visually verify that the fuse is blown.

9. Insert a new fuse into the fuse slot, as shown in Figure 20.

Figure 20.  Replacing the Blown Fuse in the NI PXI-4070 or NI PXI-4072

10. Gently press the fuse with the screwdriver until both fuse clamps snap the 
fuse into place.

1 Fuse 2 Fuse Slot

1 Fuse 2 Fuse Slot

1

2

1

2
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♦ NI PCI-4070

1. Remove all front panel connections from the NI PCI-4070.

2. Power down the chassis and remove the device.

3. Hold the NI PCI-4070 at the angle shown in Figure 21, and locate the 
fuse holder.

4. Insert a screwdriver into the slot on the fuse holder.

5. Turn counterclockwise.

6. Pull out the fuse holder and remove the 5 × 20 mm fuse.

7. Visually verify that the fuse is blown.

8. Insert a new fuse into the holder and slide the holder back into place.

9. Turn the fuse holder clockwise until it snaps shut.
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Figure 21.  Removing the Fuse from the NI PCI-4070

Appendix D: Technical Support Resources

NI Web Support
National Instruments Web support is your first stop for help in solving 
installation, configuration, and application problems and questions. Online 
problem-solving and diagnostic resources include frequently asked 
questions, knowledge bases, product-specific troubleshooting wizards, 
manuals, drivers, software updates, and more. Web support is available 
through the Technical Support section of ni.com.

1 Fuse Holder
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A Declaration of Conformity (DoC) is our claim of compliance with the 
Council of the European Communities using the manufacturer’s declaration 
of conformity. This system affords the user protection for electronic 
compatibility (EMC) and product safety. You can obtain the DoC for your 
product by visiting ni.com/certification. If your product supports 
calibration, you can obtain the calibration certificate for your product at 
ni.com/calibration.

Worldwide Support
National Instruments corporate headquarters is located at 
11500 North Mopac Expressway, Austin, Texas, 78759-3504. 
National Instruments also has offices located around the world to help 
address your support needs. You can access our branch office Web sites from 
the Worldwide Offices section of ni.com. Branch office Web sites provide 
up-to-date contact information, support phone numbers, email addresses, 
and current events. 

If you have searched the technical support resources on our Web site and still 
cannot find the answers you need, contact your local office or National 
Instruments corporate. For telephone support in the United States, dial 
512 795 8248. For telephone support outside the United States, contact your 
local branch office: 

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, 
Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 
Canada (Calgary) 403 274 9391, Canada (Ottawa) 613 233 5949, 
Canada (Québec) 450 510 3055, Canada (Toronto) 905 785 0085, 
Canada (Vancouver) 604 685 7530, China 86 21 6555 7838, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, 
Germany 49 0 89 741 31 30, India 91 80 51190000, Israel 972 0 3 6393737, 
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Malaysia 603 9131 0918, Mexico 01 800 010 0793, 
Netherlands 31 0 348 433 466, New Zealand 0800 553 322, 
Norway 47 0 66 90 76 60, Poland 48 22 3390150, 
Portugal 351 210 311 210, Russia 7 095 783 68 51, 
Singapore 65 6226 5886, Slovenia 386 3 425 4200, 
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, 
Taiwan 886 2 2528 7227, Thailand 662 992 7519, 
United Kingdom 44 0 1635 523545



CVI™, FlexDMM™, LabVIEW™, Measurement Studio™, National Instruments™, NI™, ni.com™, NI-DAQ™, and NI-DMM™ are 
trademarks of National Instruments Corporation. Product and company names mentioned herein are trademarks or trade names of 
their respective companies. For patents covering National Instruments products, refer to the appropriate location: Help»Patents in 
your software, the patents.txt file on your CD, or ni.com/patents.

© 2002–2004 National Instruments Corp. All rights reserved.
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